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1. Safety Information

 

               Read the Safety Chapter

Failure to review the Safety chapter and follow the safety warnings can result in death or 
serious injury. 

 l All personnel involved with the operation or maintenance of this product must read 
and understand the information in this safety chapter.

 l Follow all applicable safety codes of the facility as well as national and international 
safety codes.

 l Know the facility safety procedures, safety equipment, and contact information.
 l Read and understand each procedure before performing it.

 

This operation manual contains important operating and maintenance instructions which must be read, 
understood, and followed by the product user. Failure to use this product according to this operation 
manual may degrade or defeat the protection normally provided by this product. Read this manual prior 
to product use and keep it for future reference.
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Azenta Life Sciences 1. Safety Information

Part Number: 383555 Rev. E Safety Instructions

Safety Instructions

NOTE: This product has been tested to meet the requirements of IEC/EN 61010-1:2010, 
UL 61010-1 (2012) and CAN/ CSA-C22.2 No. 61010 (2012).

 

If the equipment is used in a manner not specified by the manufacturer, the protection provided by the 
equipment may be impaired. 

Reference the following list of safety instructions:

 l Keep the device away from humidity.
 l Check the voltage of the power source before you connect the equipment to the power outlet.
 l Take care not to spill any liquid on the printer.
 l Only qualified service personnel should unscrew the base of the instrument or touch the back the LCD 

display.
 l Turn off the power and unplug the device before maintenance.
 l Do not touch any moving parts.
 l Only use the Direct Tube Marker with the AC/DC adapter provided with the equipment.
 l If the power supply is damaged please do not attempt to use the Direct Tube Marker.
 l Do not position the Direct Tube Marker so that it is difficult to operate the disconnecting device (detachable 

plug).

Copyright © 2024, Azenta, Inc. 7



1. Safety Information Direct Tube Marker

Regulatory Compliance and Declaration of
Conformity

Part Number: 383555 Rev. E

Regulatory Compliance and Declaration of Conformity

The Direct Tube Marker meets the requirements of the European Union’s Machinery Directive 
2006/42/EC and 2014/30/EU as a completed machine. In accordance with the Directive, Azenta Life 
Sciences has issued a Declaration of Conformity and the Direct Tube Marker has a CE mark affixed.
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2. Introduction

The following chapter details the external and internal parts of the Direct Tube Marker and includes a 
list of all contents within the product's package. 
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2. Introduction Direct Tube Marker

Product Overview Part Number: 383555 Rev. E

Product Overview

The Direct Tube Marker allows printing directly onto the surface of a wide range of tubes including  
centrifuge and cryogenic vials from 0.5 – 50 ml in volume, limiting need and use of sticky labels or 
marker pens. Markings are resistant to ethanol, isopropanol, water, DMSO, liquid nitrogen and 
mechanical stress. The prints are also stable over a wide temperature range (-196°C to 100°C). 
Markings do not stain your hands when touching the tubes.

 

NOTE: Resistance varies between ribbon colors. Please refer to the Direct Tube Marker 
website on www.azenta.com for an overview chart of ribbon resistance & compatibility.

 

Our label design software gives the user complete flexibility when creating their label layout. Each piece 
of data, be it text, barcodes or graphic files can be placed independently of one another. Depending on 
the printing needs, this ensures the correct data is called upon for each cell or emphasis is given to the 
most important information.

The instrument also prints linear barcodes and 2D codes in various module sizes and graphic files 
(.bmp, .jpg, .gif, .png) such as company logos. Print orientation can be set within 360°.
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Part Number: 383555 Rev. E Package Contents

Package Contents

 

Package Contents

Direct Tube Marker

3 X Tube Adapters

Tube Adapter Hole Diameter Product Code

Tube Adapter for 1.5 ml/2 ml tubes 11.5 mm 4ti-0681

Tube Adapter for 2D cluster tubes 8.5 mm 4ti-0683

Tube Adapter for cryo tubes 12.7 mm 4ti-0684

AC adapter 30W 18VDC (input 100-240VAC)

7 mm magnetic pole adapter

USB A-B cable

2.5 mm hex key for Pivot Point adjustment
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2. Introduction Direct Tube Marker

Direct Tube Marker Parts Part Number: 383555 Rev. E

Direct Tube Marker Parts

Direct Tube Marker External Parts

Direct Tube Marker Front

Number Description

1 Tube Adapter

2 LCD Display

3 Top Cover

 

Direct Tube Marker Back

Number Description

1 Keyboard Connector (USB/A)

2 PC Connector (USB/B)

3 DC Power Connector
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Azenta Life Sciences 2. Introduction

Part Number: 383555 Rev. E Direct Tube Marker Parts

Direct Tube Marker Internal Parts

Number Description

1 Sled

2 Solenoid lifter

3 Adjustable Pivot Point

4 Ribbon Tensioner

5 Un-printed Ink Ribbon

6 Adjustable Support Base Knob

7 Printhead

8 Dust Collector

9 Adapter Guide Pin

10 Tube Sensor

11 Printed Ink Ribbon

12 Spool Locking Cap

Copyright © 2024, Azenta, Inc. 13



3. Software Installation

The following chapter details the installation process for the  Direct Tube Marker software.
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Azenta Life Sciences 3. Software Installation

Part Number: 383555 Rev. E Installing Direct Tube Marker Software

Installing Direct Tube Marker Software

To install the software, you must execute the installer file. Follow the steps below to install your new 
Direct Tube Marker software.

 

Step Action

1.   Download the  Direct Tube Marker software from https://www.azenta.com/resources/direct-tube-marker-
software.

2.  

Locate the Direct_Tube_Marker_Setup_<version>.exe file and double-click it.
The Install window opens.
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3. Software Installation Direct Tube Marker

Installing Direct Tube Marker Software Part Number: 383555 Rev. E

Step Action

3.  

Select the Install button. 
 

 
The Install Loading window appears.
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Azenta Life Sciences 3. Software Installation

Part Number: 383555 Rev. E Installing Direct Tube Marker Software

Step Action

4.  

The FTDI CDM Drivers window opens. 
 

 
Select the Extract button. 
 

 
The Welcome Device Drive Installation window opens.
 

Copyright © 2024, Azenta, Inc. 17



3. Software Installation Direct Tube Marker

Installing Direct Tube Marker Software Part Number: 383555 Rev. E

Step Action
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Azenta Life Sciences 3. Software Installation

Part Number: 383555 Rev. E Installing Direct Tube Marker Software

Step Action

5.  

Select the Next button.
 

 
The License Agreement window opens.
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3. Software Installation Direct Tube Marker

Installing Direct Tube Marker Software Part Number: 383555 Rev. E

Step Action

6.  

Select the radio button next to the I accept this agreement option.
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Azenta Life Sciences 3. Software Installation

Part Number: 383555 Rev. E Installing Direct Tube Marker Software

Step Action

7.  

Select the Next button. 
 

 
The Completing Device Driver Installation window opens.
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3. Software Installation Direct Tube Marker

Installing Direct Tube Marker Software Part Number: 383555 Rev. E

Step Action

8.  

Select the Finish button.
 

 
The Installation application automatically closes.

9.  

Locate your computer’s Search function.
 

 
Type Direct Tube Marker into the Search function.
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Part Number: 383555 Rev. E Installing Direct Tube Marker Software

Step Action

10.  

Double-click the Direct Tube Marker application to open the software.
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4. Hardware Installation

The following chapter details how to install the Direct Tube Marker hardware.
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Azenta Life Sciences 4. Hardware Installation

Part Number: 383555 Rev. E How to Install a Ribbon for Printing

How to Install a Ribbon for Printing

NOTE: Where possible, gloves should be worn when installing the ribbon. This ensures 
the ink is not stained by the grease from your fingers.

 

Number Description

1 Ink Ribbon, Ink Side

2 Drive Shaft

3 Ink Ribbon

4 Ink Ribbon, Glossy Side

5 Spool Locking Cap
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4. Hardware Installation Direct Tube Marker

How to Install a Ribbon for Printing Part Number: 383555 Rev. E

Step Action

1.   Open the top cover of the printer.

2.   Remove the spool locking cap.

3.  

Insert the ink ribbon on the right-hand drive shaft. 
 
NOTE: Ensure that the pin at the base of the drive mechanism shaft goes into the slot on the ink ribbon 
core. Check that the core goes all the way down and there is no gap between the bottom of the ribbon 
and the base of the drive mechanism.

4.   Thread the ink ribbon through the path highlighted by the red line in the picture above.

5.   Insert the empty ink ribbon core onto the left-hand drive shaft. 
Ensure the slot in the core is flush over the pin at the base of the shaft.

6.  

Attach the ribbon to the empty ink ribbon core  using thin adhesive tape.
 
NOTE: Make sure that the lower edge of the ink ribbon is as close to the black drive mechanism as 
possible and that it is not wrinkled.

7.   Lock the spool and ribbon in place by screwing the spool locking cap down, this will help to align the ribbon.

8.   Turn the drive mechanism and core clockwise until the start of the ink ribbon is on the core. 
If necessary, turn the right hand side ink ribbon roll clockwise to tighten the ribbon.

9.   Close the top cover and proceed to  "How to Connect Printer to a PC" on page 35.
The Direct Tube Marker will carry out a calibration procedure at start-up.

10.  

If start-up is interrupted the unit will auto-calibrate before the first print.
 
NOTE: The glossy side of the ink ribbon should be against the printhead, otherwise the printhead might 
be damaged when used.
Avoid touching the unused area (between the printhead and right-hand side roll holder) of the ink ribbon 
with bare hands. Any dirt or grease on the ink ribbon will reduce the print quality.
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Azenta Life Sciences 4. Hardware Installation

Part Number: 383555 Rev. E How to Set-up Tube Support

How to Set-up Tube Support

Selecting and Installing Tube Adapter

The Direct Tube Marker delivery package contains tube adapters for 1.5 ml / 2 ml tubes (4ti-0681, hole 
diameter 11.5 mm), 0.5 ml PCR and 96 racked 2D storage tubes (4ti-0683, hole diameter 8.5 mm) and 
cryo tubes (4ti-0684, hole diameter 12.7 mm).

To print on tubes that are not supported by the standard adapters please refer to our website 
www.azenta.com to see the latest additions to the Direct Tube Marker portfolio. The tube adapter is 
selected according to the tube diameter.

Direct Tube Marker Tube Adapter Hole Diameter Product 
Code

Tube Adapter for 1.5 ml / 2 ml Tubes 11.5 mm 4ti-0681*

Tube Adapter for 2D Cluster Tubes 8.5 mm 4ti-0683*

Tube Adapter for Cryo Tubes 12.7 mm 4ti-0684*

Tube Adapter for 2 ml Screw Cap Tubes (10 mm Diameter) 10.4 mm 4ti-0685-1

Tube Adapter for 15 ml Tubes 18 mm 4ti-0685-2

Tube Adapter for 50 ml Tubes 30 mm 4ti-0685-3

Tube Adapter for Matrix Tubes 8.2 mm 4ti-0685-4

Tube Adapter for 0.2 ml Tubes 6.4 mm 4ti-0685-5

 

NOTE: These items are included with the Direct Tube Marker (Code 4ti-0680-1)

 

Tubes without a collar will be supported from the bottom via an adjustable adapter. They will also be 
aligned with the print head from the top via an adapter plate.

Tube adapters for tubes not fitting to any of the existing adapters are available on request. Please 
contact Azenta at www.azenta.com.
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4. Hardware Installation Direct Tube Marker

How to Set-up Tube Support Part Number: 383555 Rev. E

Step Action

1.   Insert the tube adapter on the sled. 

2.  

Check that the plate guide pin slots into the small hole in the tube adapter.
 

Number  Description

1 Tube Adapter Guide Pin
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Azenta Life Sciences 4. Hardware Installation

Part Number: 383555 Rev. E How to Set-up Tube Support

Setting Adjustable Support Platform

Housed within the Direct Tube Marker unit is an adjustable support platform from which tubes without a 
lip or collar can be fully supported. Integrated within the support platform is a magnet which attracts 
and stabilizes the magnetic pole attachment used to support tubes of less than 65 mm in length and do 
not have a collar or lip. 

The magnet within the support platform has been designed and positioned in such a way to help users 
perfectly locate the pole attachment and eliminate misalignment against the printhead and sled; which 
could potentially damage these components.

Step Action

1.   Open the top cover and remove the adapter if applicable.

2.  

Turn the knob clockwise to raise the support platform.
Turning anti-clockwise will lower the platform.
 

 

NOTE: To perfectly optimize print results for your tube(s), you may need to adjust the 
pivot point of the sled to even out pressure across the whole tube surface area, "Setting 
the Sled Pivot Point" on page 32. Additionally, you may also require the use of the 7 mm 
magnetic pole attachment. See below for details how to correctly position the 
attachment.
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4. Hardware Installation Direct Tube Marker

How to Set-up Tube Support Part Number: 383555 Rev. E

Using Magnetic Pole Adapter

Step Action

1.   While connected to the software with the cover closed, go to Printer settings manager in bottom left corner 
of home screen.

2.  
Select the Sled  tab and use the up-arrow to open up the sled. 
NOTE: This gives you extra room to maneuver the pole attachment.

3.   Open the cover of the unit and remove the tube adapter to place the pole attachment.

4.  

The attachment should be placed in such a way that is fully supportive to the tube you wish to print onto. 
 

 
Once positioned, shut the cover and close the sled by using the down-arrow within the sled tab; leaving 
enough room to insert the tube for printing onto.

5.  

Insert the tube and close the sled further so the tube is locked in position. 
 

 
NOTE: You may need to make fine adjustments to tube platform height and pole attachment to optimize 
the printed label position. Ensure there is no pressure coming from the sled when making these 
adjustments.

6.  

Use the adapter plate to align the tube against the printhead and sled. 
 
NOTE: It is  recommended to always use the adapter plate as it ensures safety and reduces risk of tube 
dropping into the sled after a print has been made.
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Azenta Life Sciences 4. Hardware Installation

Part Number: 383555 Rev. E How to Set-up Tube Support

Step Action

7.  

If the tube is over 65 mm in length, there is no need for the pole attachment.
 

 
NOTE: Switch tube lift OFF in the Direct Tube Marker printer settings tab for adapters without a lift design 
or for tubes without a cap or collar.
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4. Hardware Installation Direct Tube Marker

How to Set-up Tube Support Part Number: 383555 Rev. E

Setting the Sled Pivot Point

To improve the overall print quality, users have the ability to adjust the position of the sled’s pivot point, 
increasing the surface area of the tube in which pressure is applied. This is particularly useful for larger 
tubes or those which are not printing fully near the base of the tube. The pivot point can only be lowered 
to a maximum of 14 mm below the default position. Follow the step-by-step guide below for how to 
effectively utilize the adjustable pivot point.

 

Step Action

1.   Open the top cover and remove the adapter (if applicable).

2.  
Take the 2.5 mm hex key provided and adjust the height of the pivot point. 
NOTE: To lower the pivot point turn the hex key clockwise; turning anti-clockwise will raise the pivot point.
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Azenta Life Sciences 4. Hardware Installation

Part Number: 383555 Rev. E How to Set-up Tube Support

Step Action

3.  

For best results, you want to adjust the pivot point so it is applying pressure to the center or just below the 
center of the tube you are printing on. 
The pivot point is located in the middle roller bearing of the top set of 3 roller bearings, as shown in the 
photo below.
 

Number Description

1 Hex Key

2 Pivot Point Ruler

3 Pivot Point

 

Number Description

1 Pivot Point Ruler

 
NOTE: DO NOT raise the pivot point above the default position. Default position is flush with the top of 
the sled.

4.  
Once the pivot point is in position, replace the adapter suitable for the tube(s) you wish to print onto and 
close the top cover. 
Make a note of the pivot point position by referencing the sled ruler.
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4. Hardware Installation Direct Tube Marker

How to Set-up Tube Support Part Number: 383555 Rev. E

Step Action

5.  

For tubes that do not have a lip or collar, please refer to "Setting Adjustable Support Platform" on page 29.
 

 

Below are examples of prints which were printed with the pivot point at default position and again with 
the pivot point adjusted to the center of the tube. The print quality has drastically improved and 
important label data hasn’t been lost as a result of the lowered pivot point.

Pivot point default:

  

Pivot point 10 mm lower:
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Part Number: 383555 Rev. E How to Connect Printer to a PC

How to Connect Printer to a PC

Please check the following items before connecting the power source:

 l There is no tube inside the Direct Tube Marker
 l The ink ribbon is inserted correctly
 l The tube adapter is inserted correctly
 l The Direct Tube Marker top cover is closed

Connect the DC power source plug to the connector shown in "Direct Tube Marker External Parts" on 
page 12.

The Direct Tube Marker will carry out a calibration procedure at start-up. Wait for calibration to finish 
before proceeding. If calibration is interrupted it will auto-calibrate once the first print is triggered. 
Alternatively, you can restart the Direct Tube Marker by disconnecting and reconnecting the power 
supply.

Execute Direct Tube Marker software.
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5. Preparation for Printing

The following chapter details how to prepare the Direct Tube Marker for printing.
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How to Create Label Content

How to Set the Tube Label Dimensions

In order to set the optimum tube label dimensions, ensuring all label content is printed onto the tube 
being used, you must first measure your tube to find the height and diameter parameters.

The max label height is specified according to the measurement of the straight part of the tube. This is 
between the cap and the conical part of the tube, as shown below. The maximum printing height is 40 
mm. For tubes that exceed 40 mm in length, label heights should be set to 40 mm.

The max label width is specified according to the diameter of the tube being used. Whatever the 
diameter is of the tube, this will be converted in to its measurement as a circumference. This ensures 
the end of the label will not overlap the beginning of the label.

 

NOTE: The actual tube dimensions specify the MAX label dimensions.

 

 

Example Tube Dimensions

Tube Type and Volume Tube Height Tube Diameter

0.5 ml PCR Tube 14 mm 8 mm

1.4 ml 96 Racked Storage Tube 35 mm 8 mm

1.5 ml Microcentrifuge Tube 18 mm 11 mm

2.0 ml Microcentrifuge Tube 30 mm 11 mm

1.8 ml Cryo Tube 25 mm 12 mm

15 ml Centrifuge Tube 40 mm 16 mm

50 ml Centrifuge Tube 40 mm 28 mm
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Inputting these values into the software, is done according to the following:

Step Action

1.   Start by accessing the Designer  tab on the main software screen and collapse the cell properties by 
clicking the Arrow icon.

2.   This reveals the Tube, Layout, and Print tabs.

3.  

For enhanced accessibility, select the View tab and then select the Designer button. 
 
NOTE: This will open the Designer  tab in a separate pop-out window making placement of cells and 
overall label design easier to manage.

4.  

To set the tube label dimensions, select the Tube  tab.
 

5.   Highlight and type the Height and Diameter values in the provided text boxes.
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Step Action

6.  

Once the tube parameters have been set, your label format changes to represent these. Two examples are 
shown below:
 
Example - Label format for 1.5 ml Microcentrifuge Tube (4ti-0797)
 

 
Example - Label format for 2.0 ml Microcentrifuge Tube (4ti-0798)
 

7.   You can create tube preset profiles and save them to a drop-down menu for easy access.

8.  

To access the tube preset profiles, tick the Use Tube Preset box.
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Step Action

9.  

The following menu appears.
 

10.   Added as defaults to the Tube Preset menu are 8 compatible Azenta tubes.

11.   You can add to this list by selecting the Create button.

12.   You can set the Diameter and Height parameters and edit the tube profile Name.

13.  

Select OK  to confirm and save settings.
 

14.   Once a tube profile is created, you are able to Edit or Remove it from the list.

 

How to Create Text Cells

Once your label layout has been set you can begin filling it with data.

Step Action

1.  

If you wish to make your design area larger, select the View  tab and then select the Designer button. This 
pops the screen out to a separate window, allowing you to maximize the view.
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Step Action

2.  

Within the Designer window, select the AddText button. 
NOTE: This places an 8 x 8 mm Cell in the top left corner of the label.

 

3.  

Go to the Layout tab, here you are able to set the following parameters:
 l Font (all TrueType fonts)
 l Weight (Regular, Bold and Heavy)
 l Text size (4 to 64)
 l Angle of text (360°)
 l Alignment of text (horizontal and vertical placement)
 l Wrap (NoWrap, Wrap, and WrapWithOverflow)
 l Text (Cell content entry)

 
NOTE: A visual representation of the cell size and placement is shown via the X and Y axis.

4.   To alter the width, length or position of the cell, "How to Edit Cell Size and Placement" on page 54

5.  

To edit the text in the cell you can do so in two ways:
1. By manually typing in text via the text cell within the Layout tab. "How to Edit Cell Content Manually" on 
page 48.
Or
2. By linking the cell to a specified column in the Data Spreadsheet. "How to Bind Cell Content to Data 
Spreadsheet .CSV" on page 51.
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How to Create Linear Barcode Cells

There are four variations of linear barcode to choose from: Code_128, Code_93, Code_39 and EAN_8 
with module sizes ranging from 125 μm to 375 μm.

Step Action

1.  

Within the Designer window, select the AddLbc button. This places an 8 x 8 mm cell in the top left corner of 
the label.
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Step Action

2.  

Go to the Layout tab, here you can set the following parameters:
 l Angle of barcode (360°)
 l Alignment of barcode (horizontal and vertical placement)
 l Stretch (Fill, Uniform, None and UniformToFill)
 l Module Size (125 μm, 250 μm and 375 μm)
NOTE: For 250 μm and above, expand the 1D barcode image in order to ensure that the 1D 
barcode is fully printed onto the tube.
 l Format (Code_128, Code_93, Code_39 and EAN_8)
 l Text (code content entry)

 
NOTE: A visual representation of the cell size and placement is shown via the X and Y axis.

NOTE: For 250 um and above the user will need to expand the 1D barcode image in order to ensure that 
the 1D barcode.

 

3.   To alter the width, length or position of the cell "How to Edit Cell Size and Placement" on page 54.

4.   To edit the barcode type, select from the Format drop-down menu.

5.   To edit the module size, select from the  Module Size menu.

6.  

To edit the text in the cell you can do so in two ways:
1. By manually typing in text via the text cell within the Layout tab. See "How to Edit Cell Content Manually" 
on page 48.
Or
2. By linking the cell to a specified column in the Data Spreadsheet. "How to Bind Cell Content to Data 
Spreadsheet .CSV" on page 51.
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How to Create Datamatrix Cells

There are two variations of Datamatrix ECC200 to choose from: Square and Rectangular. Module sizes 
range from 125 μm to 375 μm.

Step Action

1.  

Within the Designer tab, select the AddGfx button. 
NOTE: This places an 8 x 8 mm cell in the top left corner of the label.

 

2.  

Go to the Layout  tab, here you can set the following parameters:
 l Angle of Barcode (360°)
 l Alignment of barcode (horizontal and vertical placement)
 l Stretch (Fill, Uniform, None and UniformToFill)
 l Module Size (125 μm, 250 μm and 375 μm)
 l Quiet Zone (0-32)
 l Text (code content entry)
 l Shape (Square and Rectangle)

 
NOTE: A visual representation of the cell size and placement is shown via the X and Y axis.

 

3.   To alter the width, length or position of the cell, "How to Edit Cell Size and Placement" on page 54.
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Step Action

4.   To edit the barcode shape, select the Square or Rectangle from the Shape drop-down menu.

5.   To edit the module size, select from the Module Size menu.

6.  

To edit the text in the cell you can do so in two ways:
1. By manually typing in text via the text cell within the Layout tab. "How to Edit Cell Content Manually" on 
page 48.
Or
2. By linking the cell to a specified column in the Data Spreadsheet. "How to Bind Cell Content to Data 
Spreadsheet .CSV" on page 51.
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How to Create Graphic Files

There are four graphic file types that can be imported into the software: .bmp, .jpg, .gif and 
.png. Optimization of the graphic files should be done prior to importing.

You should aim to get your graphic as small as possible, without pixelating the content. If the graphic 
size needs to be reduced, keep in mind that 1 pixel corresponds to 0.125 mm. For example, a picture of 
100 x 100 pixels is 12.5 mm in width. Re-sizing of the graphic file needs to be done in an external 
program.

Step Action

1.  

Within the Designer window, select the Add Image button. 
NOTE: This places an 8 x 8 mm cell in the top left corner of the label.
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Step Action

2.  

Go to the Layout  tab, here you can set the following parameters:
 l Angle of Graphic (360°)
 l Alignment of Graphic (horizontal and vertical placement)
 l Image (Load)
 l Stretch (Fill, Uniform, None and UniformToFill)
 l Process (Dither, Threshold) 

 
NOTE: A visual representation of the cell size and placement is shown via the X and Y axis.

 

3.  

Select the Load  button under the image header, File Explorer opens.
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Step Action

4.  

Locate your graphic file within the File Explorer, and click OK.
 

5.   To alter the width, length or position of the cell, "How to Edit Cell Size and Placement" on page 54.

6.   To enhance the graphic process, select Threshold from the Process drop-down menu.

How to Edit Cell Content Manually

Step Action

1.   Select the cell you would like to edit, this includes Text, Linear Barcode, and Datamatrix cells.
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Step Action

2.  

Select the Layout tab. 
Type in the new data into the provided text boxes of the Text function.
 

 
NOTE: The image below describes the different text boxes within the Text feature and their differing 
properties.

 

 

Number Description

1
This is the data binding box.

If linked to the database it contains a data binding command.

2 This box shows how a text cell is displayed or what a Linear or Datamatrix cell is made 
up of.
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Step Action

3.  

Shows on the label as:
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How to Bind Cell Content to Data Spreadsheet .CSV

To link cell content to the data spreadsheet you must first have it populated with information. Please 
see "How to Enter Data into the Direct Tube Marker Spreadsheet .CSV" on page 60.

Step Action

1.  

Import a .CSV file by selecting the File tab.
 

2.  

Select Data.
 

 
Then select Import CSV.
 

NOTE: Once the file is imported the will appear in the table within the software

3.   Click on the cell you would like to edit, this includes Text, Linear Barcode, and Datamatrix cells.
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Step Action

4.  

Go to the text box within the Layout  tab of the cell you would like to edit. Write in the column header 
proceeded by  ˮ$(ˮ and ended by ˮ)ˮ.
 

 
Example: If the column you wish to extract data from is headed Tube Name you must write ˮ$(Tube Name)ˮ 
in the Text box within the Layout tab.

5.  

Shows on the label as:
 

6.   You can repeat this process for other cells that require alternative or the same information or formatting.
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Step Action

7.  

You can also link other sections of the Data Spreadsheet.CSV by entering other data binding codes, within 
the same cell if unique formatting is not essential. 
 
NOTE: This works for Text cells only.

 

 

 
Example: If you wish to populate one Text Cell from two or more columns, you must write the data binding 
codes to both columns on separate lines in the same Text Cell.
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How to Edit Cell Size and Placement

All cells are loaded into the label, defaulted to 8 x 8 mm. This means that depending on the size of Text 
or Barcodes, the content may be “squashed” within the cell and need adjusting to suit.

 

Step Action

1.  

To lengthen and/or widen the cell, you can click and drag on the cell corner diamonds.
 

2.  

To widen the cell, click and drag on the center diamond.
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Step Action

3.  

To alter the position of the cell, select in the center of the cell and drag to your chosen location.
 

4.  

To delete a cell within a label, select the cell and click the Delete button.
 

5.   Alternatively, you can clear the label contents by going to the File tab, selecting the Label button, and then 
selecting the New button.
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How to Save and Load Labels

Saving a Label

Once you have fully designed your label for production, you can save it for future use. 

Step Action

1.  

Select the File tab.
 

2.  

Select the Label button.
 

3.  

Select the Save button.
 

4.   File Explorer opens. 
From here, decide where to save the optimized label and select Save.

5.   Your label is saved and ready for the next time you need to load it.

 

Loading a Label

Should your label have already been designed, you can load a previously saved file.
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Step Action

1.  

Select the File tab.
 

2.  

Select the Label button.
 

3.  

Select the Loadbutton.
 

4.   File Explorer opens. 
From here, locate the label you wish to load.

5.   Once located, double-click on the file to load it.

How to Manually Enter Data into Direct Tube Marker Spreadsheet .CSV

Data Entry

NOTE: If multiple tubes need to be printed with the same information, you only need to fill 
one row of information. You can bind the data to a label "How to Bind Cell Content to Data 
Spreadsheet .CSV" on page 51 and print multiple copies of that one label "How to Use 
Print Mode – Single" on page 72.

 

Step Action

1.   Double-click  row 1, column 1 in the Data cell.
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Step Action

2.  

Type in the information you wish to print on to your tube.
 

3.  

Navigate to the next Data cell on the same row using the Tab key on your PC keyboard.
Continue this for all information.
 

4.   To enter Data for a new tube, click on row 2.

5.  

Continue by typing information you wish to print onto the new tube.
 

6.   Repeat the process to fill the Data Spreadsheet .CSV for all tubes that need labeling.

 

Editing Data

Step Action

1.  

To edit a particular piece of information, double-click on the Data Cell and re-type the new information.
NOTE: The inclusion of (D/M/Y) in row 2, col 2.

 

2.   To delete a piece of information, simply double-click on the Data cell, highlight the text and press the 
Delete or Backspace button on your PC keyboard.
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Step Action

3.  

To clear the whole Data Spreadsheet .CSV, select the File tab.
 

4.  

Select the Data button.
 

5.  

Select the New button.
 

Copyright © 2024, Azenta, Inc. 59



5. Preparation for Printing Direct Tube Marker

How to Enter Data into the Direct Tube
Marker Spreadsheet .CSV

Part Number: 383555 Rev. E

How to Enter Data into the Direct Tube Marker Spreadsheet .CSV

There are two ways in which the Direct Tube Marker Data Spreadsheet .CSV can be filled: manual entry 
or imported from a .csv file.

Each row represents an individual tube and is numbered; starting from 1.

Each column represents individual pieces of information relating to the tube sample and is headed; 
starting with col1.
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How to Import Data from Microsoft® Excel into Direct Tube Marker Spreadsheet 
.CSV

Direct Tube Marker software only accepts Microsoft® Excel .CSV files. You must first save any 
spreadsheet as a .CSV file before importing into Direct Tube Marker.

Data Entry

Step Action

1.  

Select the File tab.
 

 

2.  

Select the Data button.
 

3.  

Select the  Import CSV button.
 

4.   File Explorer opens. 
From here, locate the .CSV file you wish to load.

5.   Once located, double-click on the file to load it.

6.   Before completing the Import, a message asking if .CSV file uses headers appears.
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Step Action

7.  

If your .CSV file uses headers, select Yes.
 

8.  

The column headers change to represent those of the .CSV file. 
In this case Name, Patient ID, Sample Type and Date.
 

9.   To replace this information with another .CSV file, repeat the steps above.

10.  

Select the File tab.
 

11.  

Select the Data button.
 

12.  

Select the Newtab.
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How to Set the Printer Settings

Within the Direct Tube Marker printer tab, are three sub tabs: Settings, Firmware, and Sled. 

These control the settings which directly affect the hardware performance. Subtle changes can be 
made depending on the application to enhance productivity.

How to Set Printer Settings

To ensure clear and legible print quality, there are two parameters that need to be optimized for 
printing: pressing force and pre-heat.

Pressing force increases or decreases the amount of pressure the sled applies to the tube during 
printing.

Pre-heat increases or decreases the amount of heat applied to the tube via the printhead.

Step Action

1.  

To change these settings, select the Settings  tab.
Type the values of the Pressing Force and Pre-Heat in the provided text boxes. 
NOTE: It is recommended to use a Pressing Force of 25 or 30 (without preheat) as a starting point for 
every new tube type.
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Step Action

2.  

You can choose to use the default settings, as recommended by Azenta.
To do so, tick the Preset box.
 

 
Select the drop-down menu to choose from 4 options: 4ti-0686 (blue), 4ti-0688 (white), 4ti-0689 (black) 
and 4ti-0689-1 (black, universal).
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How to Enable Tube Lift (On/Off)

Step Action

1.   To enable/disable the tube lift, select the Settings  tab.

2.  

To enable Tube Lift, tick the Tube Lift box.
 

3.  

To disable Tube Lift, un-tick the Tube Lift box.
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How to Control the Sled Movement

Step Action

1.   To manually control the sled, select the Sled tab.

2.   Ensure the top cover is closed.

3.  

Select the Move arrows to move the sled forward or backwards.
NOTE: The ↑ moves the sled back and the ↓ to move the sled forward.
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How to Perform a Firmware Update

Step Action

1.   To upload the latest version of firmware, select the Firmware  tab.

2.  

The current, minimum, and available firmware versions for the software are displayed.
 

3.   To load the latest version of firmware, select the drop-down menu and select the latest version number.

4.   Select Install.

5.  

Open the cover and select  OK.
 

6.  

Wait for the firmware to load.
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Step Action

7.  

Close the cover and select OK.
 

8.  

Select the Instrument tab. 
 

9.  

Select the Detect button.
 

10.   The Direct Tube Marker re-connects to the PC and appears on the left-hand side of the screen.

11.  

Select the Firmware tab to ensure the firmware has updated properly
NOTE: If the firmware updated properly it is listed as the latest version.
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There are three printing modes to print your tube labels.

If the whole spreadsheet needs to be printed onto multiple tubes where the data varies from tube to 
tube, go to the Print tab, and select the All button.

If only selected data is needed to print onto several tubes, go to the Print tab, then click the Selected 
button.

If only one variation of label needs to be printed onto several tubes, go to the Print tab, then select the 
Single button.

Reference "Preparation for Printing" on page 36 to create your label. 

Go to the Print tab, found in the Designer window or on the Navigation Bar.

NOTE: Choosing to print via the Designer window, gives you access to the Print Preview.
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How to Use Print Mode – All

NOTE: To improve and speed up throughput, you can connect multiple printers to one PC 
and control them all through one piece of software. "How to Print using Multiple Printers" 
on page 74.

 

Step Action

1.  

Go to the Print  tab, found in the Navigation Bar.
NOTE: This same function can be found in the Designer window. 

2.   Select the All button, printing starts from data found in row 1.

3.  

The Print Manager window appears and provides a live and visual representation of the label data it is 
waiting to print.
 

4.  

Insert a blank tube, Direct Tube Marker automatically begins to print. 
The Print Manager confirms this.
 

 

5.   Continue this process for the whole spreadsheet. 
Printing automatically finishes once the last tube has been printed onto.
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How to Use Print Mode – Selected

NOTE: If for any reason a label(s) hasn’t printed properly, this feature is particularly 
useful, so you can print them again without having to select and print the data one by 
one.

 

Step Action

1.  
Go to the Print  tab, found in the  Navigation Bar.
NOTE: This same function can be found in the Designer window. 

2.  

Highlight the rows of data you wish to print by clicking and dragging over them, or, by holding down the Ctrl 
key and selecting individual rows of data within the spreadsheet.
 
Example - Only Rows 3 – 5 that have been highlighted, are printed when using the Selected print mode.
 

 
Example - Only Rows 2, 4, and 6 that have been highlighted, are printed when using the Selected print 
mode.
 

3.   Select the Selected button.

4.   The Print Manager window appears and provides a live and visual representation of the label data it is 
waiting to print. Printing starts from the lowest numbered row.

5.   Insert a blank tube, Direct Tube Marker automatically begins to print. 
The Print Manager confirms this.

6.   Continue this process until the last tube is printed. 
Printing automatically finishes once the last tube has been printed onto.
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How to Use Print Mode – Single

Step Action

1.  
Go to the Print  tab, found in  the Navigation Bar.
NOTE: This same function can be found in the Designer window. 

2.  

Highlight the row of data you would like to print.
 

3.   Select the Single button.

4.   The Print Manager window appears and provides a live and visual representation of the label data it is 
waiting to print.

5.   Insert a blank tube, Direct Tube Marker automatically begins to print.
The Print Manager confirms this.

6.   Continue this process until you are done printing.

7.   When you are finished printing on your tubes, press Done.

72 Copyright © 2024, Azenta, Inc.



Azenta Life Sciences 6. Printing Modes

Part Number: 383555 Rev. E How to Adjust the Ribbon during Print Mode

How to Adjust the Ribbon during Print Mode

In the event the ink ribbon needs changing OR in the unlikely event the ribbon becomes snagged or 
tears during a print, you can immediately open the cover of the instrument to repair or replace it.

Being able to adjust the ribbon ensures no loss of data is experienced or your position in the print 
queue compromised. Follow the steps below:

Step Action

1.   Leave the Print Manager open.

2.   Remove tube.

3.  
Open cover.
NOTE: Upon opening the cover, the green light turns red and shows the instrument is disconnected, the 
Print Manager’s job status goes blank.

4.   Remove the tube adapter.

5.   Repair or replace the ink ribbon.

6.   Reposition the tube adapter.

7.  
Close the cover and wait for calibration to complete.
NOTE: Calibration is only carried out when the unit has been switched off and on.

8.   Wait an additional 2 seconds for the Print Manager’s job status to update to “Waiting for blank tube.”

9.   Insert tube and continue printing.
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7. How to Print using Multiple
 Printers

The Direct Tube Marker software can control and send label data up to 16 printers. This increases 
throughput and productivity whilst ensuring labels are not duplicated. 
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How to Connect a Printer to Software

Connect the required amount of Direct Tube Marker printers to your PC following "How to Connect 
Printer to a PC" on page 35

Once the hardware is connected, you need to connect to the software. Upon execution of the software, 
all printers connected to the PC will Enumerate and connect automatically.

Connected printers are displayed in the bottom left corner of the main screen, each printer will have its 
own individual Tab.

Each printer tab is unique to one another, meaning completely different settings can be used from 
printer to another. For example, you may load different settings depending on if some labels require 
printing in blue ink and some require printing in black ink.

Below you will see that the first printer (Direct Tube Marker) is loaded with the 4ti-0689-1 (universal 
black) ribbon, whereas, the second printer (Direct Tube Marker) is loaded with 4ti-0686 (blue) ribbon.

 

 

You can also re-name each printer. For example the printers have been re-named to show the ink ribbon 
they have been loaded with.

If connecting a printer with the software open and connected to a printer already you must follow the 
instructions below:

Step Action

1.   Connect the printer and PC following "How to Connect Printer to a PC" on page 35.
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Step Action

2.  

Select the Instrument tab. 
 

3.  

Select the Detect button.
 

4.  

A pop-up window opens, displaying the connected printers.
 

5.   To connect a printer(s) to the software that are not connected to the software already, select the 
Enumerate button.

6.  

Previously connected printers appear with the last known name and settings. New printers appear with 
their default names and settings.
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How to Print using Multiple Printers

Once all printers have been connected and settings for each printer have been established, you can 
begin printing your tubes.

Step Action

1.  
Depending on the amount of labels you need to print, choose from the three print modes available.
NOTE: See "Printing Modes" on page 69.

2.  

Upon selecting your chosen print method, the Print Manager appears and displays a label per connected 
printer.
 

3.  

Insert blank tubes, each Direct Tube Marker automatically begins to print.
The Print Manager confirms this.
 

4.   Once those tubes have been printed onto, the Direct Tube Marker printers  wait to print the next labels in 
queue.

5.   To end printing early, select the Done button.
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How to Disconnect a Printer from Software

Step Action

1.   Select the printer you would like to disconnect, by selecting the Applicable tab.

2.  

Select Enable, to deselect the box.
 

3.   Remove the power supply.

4.  

The selected printer is now disabled. 
Printing starts from the connected printers.
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8. Error Messages/Troubleshooting

The following chapter details possible error messages and problems that require troubleshooting on the  
Direct Tube Marker instrument.
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Error Messages

Message Reason

Insert new tube Insert new tube; printing is ready but the tube has not been changed before printing the 
next tube.

No tube No tube inserted and trying to print.

Cover open The top cover is open or not completely closed. When in automatic printing mode, if the 
top cover is opened the data sent to the printer is erased.

Text field empty The text field is empty and numbering is not in use.

Force sensor fault The pressing force sensor might be damaged. Contact Azenta at 
www.azenta.com/contact-us.

Ribbon fault The ink ribbon is loose, broken or not inserted. Check that the ribbon is inserted 
correctly. If the problem persists, contact Azenta at www.azenta.com/contact-us.

Tube detector fault Tube detection components might be damaged. Contact Azenta at 
www.azenta.com/contact-us.

Power supply fault

Incorrect DC power supply connected to the device. Check that the device is connected 
to the power supply which came with the device. The operating voltage is marked on 
the label on the back of the Direct Tube Marker. 
 
NOTE: The device might be damaged if incorrect power supply is used.

Hardware error Some of the electric components might have a fault. Contact Azenta at 
www.azenta.com/contact-us.

Memory error Some of the electric components might have a fault. Contact Azenta at 
www.azenta.com/contact-us.
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Troubleshooting

Troubleshooting - General

If the problems persist, contact Azenta at azenta.com/contact-us.

Problem Solution

Power supply connected but the display is not on

The Direct Tube Marker is in power save 
mode. 
 
Execute software if closed, this will wake the 
Direct Tube Marker up and connect to the PC.
 
 
Enter printing mode to end the power saving 
mode. 
 
Alternatively, press OK in the Settings menu 
to end power saving mode. 
 
Press the space bar when using the Direct 
Tube Marker with the keyboard.

There is an error message on the display

Check the message in "Error Messages" on 
page 80 and act according to the 
instructions. 
 
The message disappears by pressing Space 
on the keyboard use or press OK on the pop-
up message in software.

How to replace/install the ink ribbon

Open cover and close software down first to 
send Direct Tube Marker to sleep mode. 
Shutdown in keyboard use. 
 
Insert the ink ribbon according to the 
instructions in See "How to Install a Ribbon 
for Printing" on page 25.
 
Once inserted, close the cover, wait for auto-
calibration to finish, and re-execute the 
software or press the space bar when in 
keyboard use. 
 
Make sure that the chosen tube type is 
correct before continuing printing.
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Problem Solution

How to replace/install a ribbon

Open cover and close software down first to 
send Direct Tube Marker to sleep mode. 
Shutdown in keyboard use.
 
Check that the ink ribbon is set correctly (See 
"How to Install a Ribbon for Printing" on page 
25.
 
Make sure that the ribbon core sits firmly on 
the shaft and the pin at the base of the drive 
mechanism shaft goes into the slot on the ink 
ribbon core to allow for correct movement of 
the ribbon core.

The Direct Tube Marker appears to be working, but no text can be 
seen on the tube surface

Check that the settings are optimized for the 
tube chosen (See "How to Create Label 
Content" on page 37) and that the ink ribbon 
is set correctly (See "How to Install a Ribbon 
for Printing" on page 25). 

Bad quality printing

Ensure that the tubes are free of fingerprints.
 
Ensure that the ribbon is clean.
 
Check that the settings are optimized for the 
tube chosen (See "How to Create Label 
Content" on page 37).
 
Check that the ink ribbon is set correctly (See 
"How to Install a Ribbon for Printing" on page 
25). 
 
Please also refer to "Troubleshooting ‒ 
Insufficient Printing Quality" on page 83.
 
NOTE: The surface of the tubes must be 
flat. The use of tubes with embossed scale 
should be avoided.
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Troubleshooting ‒ Insufficient Printing Quality

Problem Example Solution

Bad quality printing at top edge

Check that the ribbon is flat and not wrinkled. 
 
If necessary, correct the position of the ribbon but 
remember to switch unit off first.

Patchy print image

As the print head in the Direct Tube Marker is flat, 
it is very sensitive to surface changes. 
 
Try to ensure tubes are as flat as possible. 
 
Additionally, you can increase pressing force, clean 
the print head and ribbon tensioner. Ensure the 
ribbon is set correctly and is clean.

Distorted/stretched print image Contact Azenta at www.azenta.com/contact-us.

Print correct, but faint print 
image

Increase pressing force and additional heating 
time, for more details See "How to Set Printer 
Settings" on page 63.

 

Please contact Azenta at 
www.azenta.com/contact-us should the problem 
persist.

Print is not complete

Check that the settings are optimized for the tube 
chosen (See "How to Create Label Content" on 
page 37).

 

The preview box shows what the print outcome 
looks like. You may have to adjust font type, size, 
and text orientation to fit it within the tube area. 
 
Adjust the pivot point of the sled so that the 
pressure is centralized in the middle of the printing 
area.

Print correct, but not lasting 
(scratches off) N/A Add additional heating time (See "How to Set the 

Printer Settings" on page 63).
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9. Maintenance

The following chapter details how to perform maintenance on the Direct Tube Marker instrument.
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Cleaning the Printhead

To ensure high quality printing, the ceramic surface of the printhead should be cleaned at a regular 
interval to remove any dirt or dust that might accumulate. This also applies to the ribbon tensioner 
surface.

 

NOTE: Touching the printhead with bare fingers should be avoided. Any dirt or grease 
might cause corrosion and damage the printhead.

 

To clean the printhead utilize the following procedure:

Step Action

1.   Go to the Printer Settings menu and drive the sled farther away from the printhead by pressing the up-
arrow button.

2.   Open the top cover.

3.   Remove the tube adapter.

4.   Loosen the ink ribbon by twisting the right-hand side ink ribbon roll counter-clockwise until the ink ribbon is 
loose enough to be moved a few centimeters away from the printhead.

5.  

Twist the dust collector (See "Direct Tube Marker Parts" on page 12) a little until the cleaner area is located 
towards the ink ribbon. 
 
NOTE: If the dust collector is dirty, remove it, clean it and put it back again. Pressurized air can be used 
to remove the dust.

6.   Wipe the ceramic area of the printhead (the area which is against the ink ribbon in normal use) with a lint-
free cloth moistened with alcohol.

7.   Wait until the alcohol evaporates from the surface of the printhead.

8.   Tighten the ink ribbon by turning the right-hand side ink ribbon roll clockwise until the ink ribbon is 
according to the picture in "How to Install a Ribbon for Printing" on page 25.

9.   Check that the upper edge of the ink ribbon is on the same level with the ceramic (white) part of the 
printhead.

10.   Close the top cover.
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10. Appendices

The following chapter contains information regarding technical specifications for the Direct Tube 
Marker instrument, Direct Tube Marker accessories and ordering information, the instrument's 
warranty, the Direct Tube Marker shipping instruction procedures, and the Waste Electrical and the 
Electronic Equipment statement. 
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Appendix A: Technical Specifications

NOTE: Technical specifications are subject to change without prior notice.

 

Specification Value

Dimensions (W x L x H) 270 x 280 x 122 mm

Weight Weight 4.8 kg

Printing Area Height 6 - 40 mm

Power Supply 18V = 1670 mA 

Operating Temperature 18° to 26°C

Operating Humidity 20% to 70% relative humidity, non-condensing

Storage Temperature 10° to 40°C

Fuses Non customer-replaceable fuses in system

Computer Interface USB 2.0
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Appendix B: Accessories - Ordering Information

Accessories

Tube Adapter

Different sized tube adapters are available on request. For details please see "Ordering Information" on 
page 88, refer to our web page www.azenta.com or contact Azenta at www.azenta.com/contact-us.

Delivery package contains tube adapters with hole diameters of 8.5 mm, 11.5 mm, and 12.7 mm. 
These sizes are compatible with the most common 0.5 ml, 1.5 ml, and 2.0 ml centrifuge tubes as well 
as cryo tubes.

Ink Ribbon

Metallic blue, black, and white ink ribbons are available to print on all kind of tube colors and tubes with 
dark colored content. Choose the ribbon color that gives the best contrast to the tube color and the 
color of the tube content respectively.

For details please See "Ordering Information" on page 88, refer to our web page www.azenta.com or 
contact Azenta at www.azenta.com/contact-us.

Ordering Information

NOTE: These items are included with the Direct Tube Marker (Code 4ti-0680-1).

 

Code Description Quantity

4ti-0680-1

Direct Tube Marker
 
Includes: 3 x tube adapters (4ti-0681, 4ti-0683 and 4ti-0684); power supply; power 
adapters for UK, EU and USA; magnetic support pole adapter (4ti-0680-084); allen 
key (4ti-0680-088); USB A-B cable, manual, 12 months warranty

1

4ti-0686 Direct Tube Marker Ribbon, Metallic Blue; roll (300 m x 40 mm) 1 roll

4ti-0688 Direct Tube Marker Ribbon, White; roll (300 m x 40 mm) 1 roll

4ti-0689 Direct Tube Marker Ribbon, Black; roll (300 m x 40 mm) 1 roll

4ti-0689-1 Direct Tube Marker Ribbon, Black, Universal; roll (300 m x 40 mm) 1 roll

4ti-0681* Tube Adapter for 1.5 ml/2 ml Tubes; hole diameter 11.5 mm 1 adapter

4ti-0683* Table Cell Outside Table: Tube Adapter for 2D Cluster Tubes; hole diameter 8.5 mm 1 adapter

4ti-0684* Tube Adapter for Cryo Tubes; hole diameter 12.7 mm 1 adapter

4ti-0685-1 Tube Adapter for 2 ml Screw Cap Tubes (10 mm Diameter); hole diameter 10.4 mm 1 adapter
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Code Description Quantity

4ti-0685-2 Tube Adapter for 15 ml Tubes; hole diameter 18 mm 1 adapter

4ti-0685-3 Tube Adapter for 50 ml Tubes; hole diameter 30 mm 1 adapter

4ti-0685-4 Tube Adapter for Matrix Tubes; hole diameter 8.2 mm 1 adapter

4ti-0685-5 Tube Adapter for 0.2 ml Tubes; hole diameter 6.4 mm 1 adapter
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Appendix C: Warranty

Azenta warrants that the Direct Tube Marker (4ti-0680-1) should be free from defects in materials and 
workmanship for a period of twelve months from the date of purchase. The purchase date is 
determined by the invoice date from Azenta to the customer. If the instrument is being incorporated into 
an automated system by a third party, the warranty period may be extended by a maximum of six 
months or the date the system is commissioned, whichever is the shorter. For this automation 
extension to be valid, Azenta must be notified of this requirement along with the details of the integrator 
at the point of purchase.

Each Direct Tube Marker is tested and documented by the manufacturer before shipping. Azenta Ltd‘s 
Quality Control System guarantees that the performance of the Direct Tube Marker you have purchased 
is within its specifications.

The warranty covers all parts and labor costs associated with a repair of the unit within the first twelve 
months. The need for returning a unit for service must first be agreed with Azenta via telephone 
support. Once it is established a return is necessary, Azenta will issue a returns number, details of 
which must be returned with the unit.

The warranty does not cover defects caused by excessive wear and tear or damage due to shipping, 
accident, abuse, misuse, problems with electrical power, or usage not in accordance with product 
instructions or if other than original spare parts supplied by the manufacturer have been used.

The warranty does not automatically cover shipping charges. Shipping costs (both ways) will be covered 
by Azenta where a returns number is issued within eight weeks of the original delivery date (as 
confirmed by the invoice date). Shipping costs after this period will need to be covered by the customer.

Once returned to a Azenta designated service center, the unit will be inspected and repaired accordingly 
and a report provided to the customer. Azenta would expect to carry out this work and return the unit 
within ten working days of receiving the unit.

On site service or a swap out service (where a loaner instrument is shipped to the customer whilst theirs 
is repaired) can be arranged at extra cost. Please contact Azenta if you are interested in this service.

This standard warranty can be extended to twenty four or thirty six months respectively.

Extended warranty must be purchased within four weeks of the original invoice address.

Code Description

4ti-0680-10 12 months parts and labour warranty for 4ti-0680-1 Direct Tube Marker

4ti-0680-11 12 month warranty extension to 4ti-0680-10 for Direct Tube Marker, second year

4ti-0680-12 24 month warranty extension to 4ti-0680-10 for Direct Tube Marker, second and third year

4ti-0680-113 12 month warranty extension to 4ti-0680-11 for Direct Tube Marker, third year
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NOTE: Please contact Azenta at www.azenta.com/contact-us or your local distributor for 
pricing details.

 

The warranty does not cover damage caused to the unit in shipping due to unsuitable or insufficient 
packaging being used. Wherever possible, the original shipping box should be retained by the customer 
and used for returning the unit. Please also refer to "Shipping Instruction" on page 92.
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Appendix D: Shipping Instruction

Step Action

1.   When packing the Direct Tube Marker for shipping, ensure that the sled is in the front position.

2.  

When the power is on, you can drive the sled with the arrow buttons toward the printhead until it stops 
moving.
NOTE: If the power is off, you can manually rotate the sled drive screw so that the sled touches the front 
limiter. Do not tighten it. Please refer to the picture below.
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Step Action

3.  

The correct shipping position can be seen from the interconnection screw position.
 

Position Picture

Correct

 

Incorrect

 

 

 

NOTE: After shipping, the sled automatically moves backwards during calibration which 
happens straight after supplying power. There is no need to unlock the sled manually.

If the sled does not move after supplying power, loosening the nut by turning it once can 
resolve the problem.
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Appendix E: WEEE Statement (European Union)

The symbol above indicates that Waste Electrical and Electronic Equipment (WEEE) is not to be 
disposed of as unsorted municipal waste. Equipment marked with this symbol is to be collected 
separately.

The objectives of this program are to preserve, protect and improve the quality of the environment, 
protect human health and utilize natural resources prudently and rationally. Specific treatment of WEEE 
is indispensable in order to avoid the dispersion of pollutants into the recycled material or waste 
stream. Such treatment is the most effective means of protecting the customer’s environment.

The waste collection, reuse, recycling, and recovery programs available to Azenta Life Sciences 
customers vary by customer location. Please contact the responsible body (e.g., your laboratory 
manager) for information about local requirements.
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